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12-11-2024,07:34	AM	#1	Hi	all,	I	have	a	bunch	of	data	tables	in	my	workbook	so	naturally	I	had	my	workbook	calculation	on	Partial	rather	than	Automatic	(to	avoid	recalculating	all	the	tables	every	time	something	changes).	It	was	fine	until	recently.	Now	excel	automatically	strikes	through	most	cells	because	it	deems	them	"stale"	(although	they're
perfectly	updated).	This	formatting	doesn't	show	when	calculation	is	on	automatic	(but	obviously,	I'm	back	to	square	one	with	the	data	tables).	So	my	question	is:	is	there	a	way	to	have	calculation	on	automatic	except	for	data	tables	without	using	the	"Partial"	calculation	option	(which	creates	stale	value	formatting)?	Maybe	something	via	VBA?	I	know
I	can	deactivate	the	stale	formatting	but	other	people	using	the	spreadsheet	face	the	same	issue,	which	creates	a	lot	of	confusion!	Thanks!	12-11-2024,07:38	AM	#2	If	you	have	this	feature,	then	you	are	not	using	Excel	2019	-	would	you	please	update	your	forum	profile?	Thanks.	You	can	switch	stale	formatting	off	(scroll	down	to	see	how):	Ali
Enthusiastic	self-taught	user	of	MS	Excel	who's	always	learning!	Don't	forget	to	say	"thank	you"	in	your	thread	to	anyone	who	has	offered	you	help.	It's	a	universal	courtesy.	You	can	reward	them	by	clicking	on	*	Add	Reputation	below	their	user	name	on	the	left,	if	you	wish.	NB:	as	a	Moderator,	I	never	accept	friendship	requests.	Forum	Rules
(updated	August	2023):	please	read	them	here.	Does	this	sound	familiar	to	you:	Excel	takes	too	much	time	calculating.	Instead	of	instantly	showing	the	results,	you	have	to	wait	for	several	seconds	or	even	minutes	for	Excel	to	finish	up	the	calculation.	The	problem:	The	larger	your	Excel	model	gets,	the	more	you	getfrustrated	by	the	lack	of
performance.	In	the	previous	post,	wevealready	described	17	methods	of	speeding	up	Excel.	Now	we	are	going	to	have	a	deeper	look	at	the	calculation	methods.	Switching	from	automatic	calculation	mode	to	manual	can	save	you	some	time.	But	the	basic	question	is:	When	do	you	want	what	to	be	calculated?	You	can	set	Excel	to	automatic	calculation
or	manual	calculation	The	moment	of	calculating	means,	that	you	can	choose	between	the	two	basic	calculation	options	Automatic	and	Manual.	The	third	one	(Automatic	Except	for	Data	Tables)	is	similar	to	Automatic.	Becauseofthat	we	will	now	concentrate	on	the	two	main	options	Automatic	and	Manual.	Automatic	calculation	means,	that	after	each
change	in	your	workbook	Excel	recalculates.	Simply	speaking,	every	time	you	press	enter,	Excel	calculates	all	the	changed	cellsand	the	depending	cells	in	your	workbook.	Also,	Excel	calculates	all	volatile	functions	as	INDIRECT	or	OFFSET.	In	a	small	workbook,	you	wont	notice	that,	but	large	workbooks	can	suffer	from	performance.	Each	time,	you
ask	Excel	to	recalculate.	Therefore,	go	to	Formulas.	Under	Calculation	Options	you	canselect	Manual	(see	the	image	above).	Now,	Excel	will	recalculate	If	you	actively	initiate	a	recalculation.For	example	by	pressing	F9	or	by	going	to	Formulas	and	clicking	onCalculate	Now	(number	two	on	below	picture).If	you	save	an	Excel	file,	it	will	also	be
recalculated.	Whereas	the	firstmethod	(pressing	F9)	can	be	canceled	easily,	this	method	is	quite	stable.	When	on	manual	calculation	mode:	Keep	calm	and	press	F9.(Download	this	and	other	images	as	wallpaper	to	your	computer	or	mobile	phone)	When	on	manual	calculation	mode,	you	can	(quite	roughly	though)	select,	whichpart	of	your	Excel
workbookshould	be	recalculated:	If	you	want	the	whole	workbook	to	be	calculated:	Switch	to	manual	mode	and	press	F9	or	go	to	Formulas	and	click	onCalculate	Now.For	only	calculating	the	current	sheet:	In	the	manual	mode,	press	Shift	+F9	or	go	to	Formulas	and	click	onCalculate	Sheet.If	you	only	press	F9,	all	changes	formulas	and	following	cells
will	be	updated.	So,	when	you	have	the	feeling	that	some	formulas	arent	showing	correct	results,	you	can	force	Excel	to	recalculate	the	whole	workbook	by	pressing	Ctrl	+	Alt	+	F9.If	you	only	want	to	calculate	a	selection	of	cells/	cell	range	only,	you	have	to	look	for	a	third	party	solution.	We	included	such	function	in	our	Excel	add-in	Professor	Excel
Tools.You	cantry	it	for	free.	There	is	no	sign-up	or	installation	needed,	just	download	and	activate	it	within	Excel.Besides	that,	you	can	decide,	if	data	tables	(probably	99%	of	Excel	workbooks	dont	have	them)	should	be	recalculated.	Go	to	Formulas,	click	on	Calculation	Option	and	selectAutomatic	Except	for	Data	Tables.	After	weve	taken	a	look	at	the
different	methods,	lets	put	them	together	in	one	table.	In	the	columns	we	differentiate	between	Manual	and	Automatic	calculation.	What	to	calculate?Calculation	Mode:	ManualCalculation	Mode:	AutomaticAll	formulas	in	all	open	workbooksPress	Ctrl	+	Shift	+	F9	++Press	Ctrl	+	Shift	+	F9	++All	changes	in	all	open	workbookPress	F9or	go	to
Formulas	>	Calculate	Now	Not	selectable	when	on	automatic	modeWorksheetPressShift	+	F9or	go	to	Formulas	>	Calculate	Sheet	+Not	selectable	when	on	automatic	modeSelection	of	cellsGo	to	Professor	Excel	and	click	on	Calculate	SelectionNot	selectable	when	on	automatic	mode	In	conclusion,	in	most	situations,	you	would	be	fine	by
remembering	these	three	things:	If	Excel	becomesslow,	switch	to	manual	calculation	mode.Recalculate	everything	by	pressing	F9.Recalculate	just	the	current	sheet	by	pressing	Shift	+	F9.	How	can	financial	brands	set	themselves	apart	through	visual	storytelling?	Our	experts	explainhow.Learn	MoreThe	Motorsport	Images	Collections	captures	events
from	1895	to	todays	most	recentcoverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	EditorsPicks.Browse	Editors'	FavoritesHow	can	financial	brands	set	themselves	apart	through	visual	storytelling?	Our	experts	explainhow.Learn	MoreThe	Motorsport	Images	Collections	captures	events	from	1895
to	todays	most	recentcoverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	EditorsPicks.Browse	Editors'	FavoritesHow	can	financial	brands	set	themselves	apart	through	visual	storytelling?	Our	experts	explainhow.Learn	MoreThe	Motorsport	Images	Collections	captures	events	from	1895	to	todays
most	recentcoverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	EditorsPicks.Browse	Editors'	Favorites	Excel	is	mostly	used	for	doing	calculations,	and	one	of	its	features	is	the	ability	to	calculate	numbers	using	different	calculation	modes.	These	modes	tell	Excel	how	and	when	to	update	the
numbers	as	you	make	changes.	You	have	four	calculation	settings:	Automatic	Calculation	Mode	Manual	Calculation	Mode	Partial	Calculation	Mode	Format	Stale	Values	Calculation	Mode	In	automatic	calculation	mode,	Excel	immediately	recalculates	the	results	of	formulas	when	you	change	any	of	the	cells	they	depend	on.	This	ensures	that	the	data
you	see	is	always	up	to	date	based	on	the	latest	input.	Automatic	Calculation	is	typically	the	default	setting	in	Excel.	Its	chosen	because	it	guarantees	that	the	results	of	formulas	are	always	current,	which	is	usually	the	desired	behavior	in	spreadsheet	work.	Automatic	calculation	is	ideal	for	situations	where	real-time	data	updates	are	important,	such
as	in	dashboards	or	when	working	with	data	that	changes	frequently.	For	example,	if	Im	creating	a	dashboard	and	I	want	to	update	the	entire	dashboard	based	on	the	value	in	one	cell	(say	a	drop-down	list),	Then	having	automatic	calculation	mode	enabled	would	be	useful.	This	mode	is	useful	when	working	with	relatively	small	datasets	or	less
complex	spreadsheets,	where	the	recalculation	time	is	minimal	and	wont	noticeably	slow	down	performance.	If	performance	becomes	an	issue,	users	might	switch	to	Manual	Calculation	Mode.	In	this	mode,	Excel	recalculates	formulas	only	when	you	explicitly	request	it	(by	pressing	F9,	for	example).	This	can	significantly	improve	performance	with
large	files	but	requires	the	user	to	remember	to	manually	recalculate	for	up-to-date	results.	If	automatic	calculation	mode	is	not	currently	activated	on	your	system,	you	can	follow	these	steps	to	enable	it:	Go	to	the	Formula	tab	Go	to	the	Calculation	group	and	expand	the	Calculation	Options	Select	Automatic	In	Excel,	Partial	Calculation	Mode,
previously	known	as	Automatic	Except	for	Data	Tables,	is	a	specific	setting	for	formula	calculation.	This	calculation	mode	is	a	variation	of	the	standard	Automatic	Calculation	Mode,	with	a	key	difference	in	how	it	treats	data	tables.	Heres	a	breakdown	of	what	this	mode	entails:	The	unique	aspect	of	Partial	Calculation	Mode	is	how	it	handles	data
tables.	Data	tables,	often	used	for	what-if	analysis,	can	be	quite	resource-intensive	to	recalculate.	In	this	mode,	Excel	does	not	automatically	recalculate	data	tables	when	other	cells	change.	This	approach	can	significantly	improve	performance,	especially	in	complex	workbooks	where	data	tables	are	extensive	and	calculations	are	heavy.	In	this	mode,
data	tables	are	only	recalculated	when	you	manually	trigger	a	full	recalculation	(for	example,	by	pressing	F9).	This	gives	you	control	over	when	these	potentially	time-consuming	calculations	occur,	which	is	beneficial	for	maintaining	workbook	performance.	To	enable	Partial	calculation	mode	in	Excel,	follow	the	below	steps:	Go	to	the	Formula	tab	Go
to	the	Calculation	group	and	expand	the	Calculation	Options	Select	Automatic	Except	for	Data	Tables.	If	youre	using	a	newer	version	of	Excel,	it	may	say	Partial	instead	of	Automatic	Except	for	Data	Tables	If	you	choose	this	option,	Data	Tables	will	recalculate	only	when	you	make	a	change	to	the	Data	Table	itself	(or	you	force	recalculation	in	the
entire	sheet).	In	Manual	Calculation	Mode,	Excel	does	not	automatically	update	the	results	of	formulas	when	you	make	changes	in	your	workbook.	Instead,	formulas	are	recalculated	only	when	you	manually	trigger	the	process.	This	mode	can	significantly	improve	performance	in	large,	complex	workbooks	with	numerous	formulas,	data	tables,	or
volatile	functions	(like	RAND	or	NOW).	By	avoiding	constant	recalculations,	it	reduces	the	computational	load,	which	is	particularly	beneficial	when	making	multiple	changes	or	data	entries.	Manual	Calculation	Mode	is	useful	when	working	on	extensive	data	modeling,	complex	financial	spreadsheets,	or	scenarios	where	real-time	updates	are	not
necessary.	It	allows	for	batch	processing	of	updates,	which	can	be	more	efficient	in	certain	contexts.	You	can	recalculate	your	workbook	in	several	ways	while	in	Manual	Mode:	Pressing	F9	recalculates	all	open	workbooks.	Pressing	Shift	+	F9	recalculates	only	the	active	worksheet.	Pressing	Ctrl	+	Alt	+	F9	forces	a	complete	recalculation	of	all
formulas	in	all	open	workbooks,	regardless	of	whether	Excel	thinks	they	need	recalculation	or	not.	A	critical	aspect	of	using	Manual	Calculation	Mode	is	the	need	to	be	mindful	of	recalculating	your	data	to	ensure	accuracy.	Since	Excel	wont	update	formulas	automatically,	you	need	to	remember	to	manually	trigger	a	recalculation	to	reflect	the	most
current	data.	To	enable	Manual	calculation	mode	in	Excel,	follow	the	below	steps:	Go	to	the	Formula	tab	Go	to	the	Calculation	section	and	expand	the	Calculation	Options	Select	Manual.	In	Manual	Mode,	Excel	recalculates	all	formulas	only	when	you	explicitly	instruct	it	to	do	so.	Even	if	youve	chosen	Manual	mode,	you	will	notice	that	your	workbook
recalculates	every	time	you	save	it.	To	avoid	this,	you	need	to	follow	these	steps.	Click	Formulas	in	the	Excel	Options	dialog	box.Select	Manual	and	uncheck	the	box	Recalculate	workbook	before	saving	option.	In	case	youre	using	Manual	calculation	mode,	there	are	two	options	Excel	gives	you	to	manually	recalculate:	The	active	sheet	The	entire
workbookGo	to	the	Formula	tab	Go	to	the	Calculation	group	and	click	Calculate	Sheet	You	can	also	use	the	Shift	+	F9	keyboard	shortcut	to	recalculate	only	the	active	sheet.	Go	to	the	Formula	tab	Go	to	the	Calculation	group	and	click	Calculate	Now	You	can	also	use	the	F9	keyboard	shortcut	to	recalculate	only	the	active	sheet.	If	function	keys	are	not
enabled,	you	have	to	press	Fn	+	F9.	Even	if	you	like	manual	calculation	mode,	you	may	want	the	workbook	to	recalculate	automatically	before	saving.	Below	are	the	steps	to	enable	this:	Click	Formulas	in	the	Excel	Options	dialog	box.Select	Manual	and	check	the	box	Recalculate	workbook	before	saving	option.	Also	read:	Array	Formulas	in	Excel	The
Format	Stale	Values	feature	in	Microsoft	Excel	is	designed	to	help	users	identify	when	cells	contain	outdated	information	due	to	the	workbook	being	set	to	manual	calculation	mode.	In	manual	calculation	mode,	Excel	does	not	automatically	update	cell	values	when	their	dependent	inputs	change,	which	can	lead	to	a	situation	where	the	displayed
values	are	no	longer	correct	based	on	the	current	data	or	formulas.	This	feature	visually	indicates	which	values	are	stale	or	potentially	incorrect	because	they	have	not	been	recalculated	(by	striking	them	off	with	a	strikethrough).	Its	interesting	to	note	that	all	open	Excel	workbooks	use	the	same	calculation	mode,	regardless	of	how	you	saved	each
file.	Lets	understand	how	this	works	with	the	example	below.	Below,	I	have	three	Excel	workbooks	in	a	folder.	Automatic	1.xlsx	and	Automatic	2.xlsx	workbooks	are	saved	with	Automatic	calculation	mode	active,	whereas	Manual.xlsx	Excel	Workbook	is	saved	in	Manual	calculation	mode.	Now,	lets	see	how	calculation	mode	works	when	you	have
multiple	open	workbooks	with	different	types	of	calculation	modes.	When	you	change	the	calculation	mode	of	one	workbook,	it	applies	to	all	the	open	workbooks.Assume	that	you	have	opened	Automatic	1	and	Automatic	2	both	Excel	workbooks.	Then,	you	change	the	calculation	mode	of	the	Automatic	1	Excel	workbook	to	Manual.	Now,	Excel	has
changed	the	calculation	mode	of	the	Automatic	2	Excel	workbook	also	to	Manual.	When	you	open	multiple	Excel	workbooks,	the	calculation	mode	of	all	workbooks	depends	on	the	first	open	Excel	workbook,	and	the	calculation	mode	of	the	first	book	is	dependent	on	the	calculation	mode	it	is	saved	in.For	example,	if	you	first	open	the	Manual	Excel
workbook	and	then	open	the	Automatic	1	Excel	workbook,	the	calculation	mode	of	the	Automatic	1	Excel	workbook	will	be	changed	to	Manual.	When	you	create	a	new	Excel	workbook	when	there	are	no	open	workbooks,	the	new	workbook	uses	the	same	calculation	mode	that	was	used	for	the	last	closed	workbook.For	example,	if	you	create	a	new
Excel	workbook	and	your	last	saved	workbook	is	Automatic	2,	the	new	Excel	workbook	uses	Automatic	calculation	mode.	Other	articles	you	may	also	like:	Youre	probably	already	aware	that	Excel	has	two	main	calculation	modes:	automatic	and	manual.	Automatic	calculation	calculates	when	a	value	changes	or	based	on	specific	actions	(inserting,
deleting,	hiding	rows/columns,	or	renaming	a	worksheet,	etc.).	Manual	calculation	only	calculates	when	explicitly	requested	by	the	user:From	the	ribbon,	click	Formulas	>	Calculate	Now	(shortcut	key	F9)	to	calculate	all	open	workbooks.	From	the	ribbon,	click	Formulas	>	Calculate	Sheet	(shortcut	key	Shift	+	F9)	to	recalculate	only	the	active
worksheet.	Im	sure	everybody	would	prefer	to	use	automatic	calculation;	however,	formula	complexity	and	large	data	sets	can	cause	spreadsheet	calculation	to	be	slow.As	a	result,	some	users	set	Excel	to	manual	calculation	mode.	The	differences	between	these	two	calculation	modes	can	cause	issues	as	they	dont	always	behave	as	we	might	expect.To
some	users,	it	may	appear	the	calculation	mode	keeps	changing	all	by	itself.	In	this	post,	well	explore	what	causes	this	to	happen,	and	how	we	can	solve	it.	Table	of	Contents	The	calculation	mode	is	an	application-level	setting.This	means	it	applies	to	all	the	workbooks	open	in	Excel.If	Excel	is	in	automatic	calculation	mode,	all	workbooks	are	in	that
mode.	Equally,	if	Excel	is	in	manual	calculation	mode,	then	all	workbooks	are	also	in	manual	calculation	mode.	It	is	one	setting	that	applies	to	all	open	workbooks	in	the	Excel	session.	If	using	Excel	Online,	each	browser	window	is	treated	as	a	separate	application	and	therefore	has	its	own	calculation	settings.	So	far,	it	all	seems
straightforward.However,	what	causes	the	most	confusion	is	understanding	what	actions	cause	the	calculation	mode	to	change:	Settings	changed	by	the	user	VBA	code	Office	Scripts	The	first	workbook	opened	in	a	session	Lets	take	a	look	at	each	of	these	in	turn.	To	my	knowledge	(excluding	VBA	code	or	Office	Scripts),	there	are	two	ways	for	the	user
to	change	the	calculation	mode,	through	the	Formula	ribbon	or	through	the	Excel	Options	window.	In	the	ribbon,	click	Formulas	>	Calculation	Options	>	[Select:	Automatic	/	Auto	except	data	tables	/	Manual]	Click	File	>	Options	from	the	ribbon	to	open	the	Excel	Options	dialog	box.	Then,	in	the	Excel	Options	dialog	box	click	Formulas	>	Calculation
options	>	[Select:	Automatic	/	Manual	/	Auto	except	data	tables].	Click	OK	to	close	the	window.	Note:	Using	this	method	you	can	also	enable/disable	recalculating	when	saving.	In	the	calculation	options,	the	second	item	is	automatic	except	for	data	tables.	The	data	tables	being	referred	to	are	the	feature	found	under	Data	>	What	If	Analysis	>	Data
Tables,	it	is	not	referring	to	the	Tables	feature.	Data	tables	are	separated	because	they	can	cause	slow	calculation	due	to:	Performing	multiple	recalculations	of	the	workbook	Using	single-threaded	calculations	Data	tables	are	useful	because	they	provide	a	way	to	calculate	multiple	versions	of	a	calculation	using	different	parameters,	and	then	compare
the	variations	between	those	calculations.	However,	as	they	can	cause	slow	calculation	an	additional	option	is	available.	When	using	VBA,	it	is	easy	to	change	the	calculation	mode.The	lines	of	code	below	are	examples	of	the	types	of	how	to	change	the	calculation	mode.	Application.Calculation	=	xlAutomatic	Application.Calculation	=	xlManual
Application.Calculation	=	xlSemiautomatic	Application.CalculateBeforeSave	=	True	Application.CalculateBeforeSave	=	False	With	VBA,	it	is	common	to	change	the	calculation	mode	to	manual	at	the	start	of	a	procedure,	then	change	it	back	at	the	end,	as	it	helps	with	speed.	However,	if	the	macro	errors	or	exits	before	completion,	the	calculation
mode	will	not	return	to	its	previous	state.	So,	VBA	can	cause	unexpected	changes	in	calculation	mode	if	the	code	is	not	written	correctly.	Office	Scripts,	like	VBA,	can	change	the	calculation	mode	through	code.	workbook.getApplication().setCalculationMode(ExcelScript.CalculationMode.automatic)
workbook.getApplication().setCalculationMode(ExcelScript.CalculationMode.manual)	workbook.getApplication().setCalculationMode(ExcelScript.CalculationMode.automaticExceptTables)	Unlike	VBA,	Office	Scripts	does	not	have	any	options	to	force	calculation	before	save.	The	methods	above	make	sense,	as	they	involve	user	action	or	running	a
code.But	the	most	common	reason	for	the	switch	between	automatic	and	manual	is	not	as	apparent.	The	calculation	mode	is	most	often	changed	based	on	the	calculation	setting	of	the	first	workbook	opened	in	the	Excel	session.	Each	workbook	contains	the	calculation	mode	setting.Excel	adopts	the	calculation	mode	of	the	first	workbook	opened	in	a
session.Any	workbooks	subsequently	opened	also	adopt	the	calculation	mode	of	the	first	workbook,	irrespective	of	its	own	settings.	This	is	the	part	that	causes	the	most	problems,	as	we	dont	usually	check	calculation	settings	when	opening	a	workbook	in	a	new	session.	NOTE:	Excel	Online	treats	each	workbook	as	a	separate	application	session
therefore	it	cannot	impact	other	workbooks.	When	a	workbook	saves,	the	calculation	mode	at	the	time	of	saving	is	held	within	the	workbook.This	becomes	a	problem	for	anybody	who	does	not	understand	calculation	modes.	Lets	use	an	example:Jack	is	a	newish	Excel	user	and	does	not	know	that	calculation	modes	exist.He	believes	all	Excel	files	are
set	to	automatic	calculation;	that	is	all	he	has	ever	experienced.Jacks	work	colleague	sends	him	a	workbook	saved	in	manual	calculation	mode	via	e-mail.Jack	opens	the	workbook,	this	happens	to	be	the	first	workbook	opened	in	Excel.Jack	has	no	idea	the	calculation	mode	for	the	application	has	now	been	set	to	manual;	he	has	no	idea	that	manual	even
exists.Jack	continues	to	work	with	Excel;	opening,	modifying,	saving,	and	e-mailing	workbooks.There	are	two	issues	key	issues	here:	The	workbooks	saved	during	that	session	may	now	be	set	to	manual.If	subsequent	users	open	up	those	same	workbooks	first,	their	session	too	will	change	to	manual.	Jacks	workbooks	may	not	have	calculated	at	the
right	point	in	the	process,	and	therefore	he	has	potentially	created	workbooks	containing	lots	of	incorrect	values.	For	many	users,	manual	calculation	mode	can	become	like	a	virus	that	spreads	without	them	knowing	it.So,	the	lesson	is	to	check	your	calculation	mode	regularly.	The	quick	answer	is	that	there	is	no	fix	because	that	is	how	Excel	has	been
designed	to	operate.However,	there	are	a	few	options	to	mitigate	the	potential	problem:	Use	VBA	in	all	workbooks,	which	must	be	opened	with	automatic	calculationAdding	a	VBA	workbook	open	event	to	your	workbook	will	force	the	calculation	mode	to	change	to	automatic	each	time	the	workbook	is	opened.The	example	code	below	should	be
inserted	into	the	Workbook	code	module	Private	Sub	Workbook_Open()Application.Calculation	=	xlCalculationAutomaticEnd	Sub	However,	there	is	one	drawback	to	using	a	macro	option.Depending	on	the	users	settings	and	whether	they	click	the	button	to	enable	content,	the	macro	may	or	may	not	execute.	NOTE:	In	Excel	Online	there	is	no	way	to
automatically	trigger	an	Office	Script;	therefore,	there	is	no	online	equivalent.	Always	open	a	specific	workbook	firstA	better	option	may	be	to	save	a	workbook	with	the	correct	calculation	mode	in	your	XLSTART	folder.	That	workbook	will	always	open	first	and	set	the	calculation	mode	to	automatic	for	the	session.	An	alternative	to	having	a	workbook
in	the	start	folder	is	to	use	a	Personal	Macro	Workbook	set	to	manual	calculation,	even	if	that	it	contains	no	macros.	Find	out	more	how	to	create	a	Personal	Macro	Workbook	here:	This	will	not	prevent	the	user,	or	macros	from	changing	the	calculation	mode,	but	it	should	reduce	the	risk	of	triggering	a	change	based	on	the	first	workbook	opened.
NOTE:	Excel	Online	does	not	have	a	feature	to	open	a	specific	workbook	when	the	application	opens.	Related	Posts	Discover	how	you	can	automate	your	work	with	our	Excel	courses	and	tools.	The	Excel	Academy	Make	working	late	a	thing	of	the	past.	The	Excel	Academy	is	Excel	training	for	professionals	who	want	to	save	time.	Share	copy	and
redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution	You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if
changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	You	may	not	apply	legal	terms	or	technological
measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended
use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	Below	is	an	overview:	Download	Practice	WorkbookDownload	the	Excel	file.	Use	of	Excel	Calculation	Options.xlsm	This	is	the	sample	dataset.	Example	1	Changing	the	Formula	Calculation	Options	to	Automatic	or	Manual1.1	To	AutomaticGo	to
Formulas	>	Calculation	Options	>	Automatic.When	you	open	an	Excel	workbook,	the	Calculation	Optionis	Automatic	by	default.If	you	change	the	values	in	D5	and	D6,	the	values	in	E5,	E6	and	E12	will	automatically	update.	Note:The	Automatic	Except	for	Data	Tables	option	is	available	in	Calculation	Options	feature.	Only	data	tables	with	a	What-If
Analysis	are	affected	by	this	option;	standard	Excel	tables	continue	to	be	automatically	calculated.	1.2	To	ManualGo	to	Formulas	>	Calculation	Options	>	Manual.If	you	change	the	values	in	D5	and	D6,	the	values	in	E5,	E6	and	E12	wont	automatically	update.To	change	the	values	manually,	click	Calculate	Sheet	in	Formulas.This	is	the	output.	Example
2	Using	the	Calculate	Sheet	option	in	the	Formulas	Tab2.1	Using	the	Calculate	Now	OptionChange	values	in	your	dataset.	Here,	the	values	in	D5	and	D6.To	recalculate	all	the	sheets	in	the	workbook,	click	Calculate	Now	in	the	Formulas	tab.You	can	also	press	F9	to	recalculate	all	sheets	in	the	workbook.	2.2	Using	the	Calculate	Sheet	OptionChange
values	in	your	dataset.	Here,	the	values	in	D5	and	D6.To	recalculate	this	sheet	only,	click	Calculate	Sheet	in	the	Formulas	tab.You	can	also	press	Shift	+	F9	to	recalculate	this	sheet	only.	Example	3	Adding	Manual	and	Automatic	Calculation	Commands	to	the	ToolbarClick	Customize	Quick	Access	Toolbar	in	Toolbar.Select	More	Commands.In	Excel
Options,	choose	All	Commands	in	Choose	commands	from:.Select	Automatic	Calculation	and	click	Add	to	add	it	to	the	Toolbar.Select	Manual	and	click	Add	to	add	it	to	the	Toolbar.Click	OK.The	Automatic	and	Manual	commands	are	added	to	the	Quick	Access	Toolbar.	You	can	switch	between	automatic	and	manual.	Example	4	Using	a	VBA	Macro	to
Change	the	Formula	Calculation	OptionsGo	to	Developer	>	Visual	Basic.You	can	also	press	Alt	+	F11	to	open	the	Visual	Basic	window.Enter	the	following	code	in	the	Module	and	click	Run	or	press	F5to	run	the	code.Sub	Changing_Calculation_Option()With	ApplicationIf	.Calculation	=	xlAutomatic	Then.Calculation	=	xlManualMsgBox	("The
Calculation	Option	is	set	to	Manual")Else.Calculation	=	xlAutomaticMsgBox	("The	Calculation	Option	is	set	to	Automatic")End	IfEnd	WithEnd	SubBefore	running	the	code,	the	Calculation	Options	were	set	to	Automatic.After	running	the	code	youll	see	the	following	message:	The	Calculation	Option	is	set	to	Manual.Click	OK.The	Calculation	Options	are
in	Manual	mode.If	you	run	the	code	again,	the	Calculation	Options	will	change	to	Automatic.	Example	5	Enabling	Iterative	Calculations	in	the	File	TabEnter	the	following	formula	using	the	IF	and	NOW	functions	in	D5	and	drag	down	the	Fill	Handle	to	see	the	delivery	time	of	the	products	whose	delivered	status	is	yes.	=IF(C5="yes",	IF(D5="",NOW(),
D5),	"")	No	results	are	displayed,	as	the	formula	has	a	circular	reference.To	enable	the	Iterative	Calculation,	go	to	the	File	tab.Select	Options	in	the	Home	tab.In	the	Excel	Options	window,	selectFormulas.Check	Enable	iterative	calculation.Click	OK.The	formula	is	working:	Note:You	can	also	set	the	frequency	of	recalculations	by	changing	values	in
Maximum	Iterations	(the	higher	the	number,	the	more	slowly	the	recalculation),	and	in	Maximum	Change	(the	accuracy	of	the	result	and	the	length	of	recalculation	increase	with	decreasing	numbers).Maximum	Iterations	and	Maximum	Change	are	set	to	100	and	0.001	by	default.	Example	6	Setting	the	Calculation	Precision	in	the	File	TabEnter
200.002	in	C5	and	200.003	in	C6.Excel	displays	200.00	in	both	cells.	They	are	set	to	display	2	decimal	places	only.Add	those	numbers	to	E13.400.01	is	displayed:	it	computes	the	stored	values	(200.002	and	200.003).To	change	the	calculation	to	the	displayed	value,	go	to	the	File	tab.Select	Options	in	the	Home	tab.In	the	Excel	Options	window,	go	to
Advanced.Check	Set	precision	as	displayed.Click	OK.Youll	see	that	the	value	in	E13	changed	to	400.00:	it	is	computing	the	displayed	values.	Excel	Calculation	Options	:	Knowledge	Hub	What-If	Analysis	>	Data	Table).	In	the	box	that	appears,	select:	(i)	2019	revenue	growth	rate	as	the	Row	input	cell:	(cell	D4);	and	(ii)	2019	EBITDA	margin	as	the
Column	input	cell:	(cell	D7).	Click	OK.	4.	Format	the	Table:Finally,	format	or	conditionally	format	the	values	in	the	table.	Set	the	font	colour	of	the	cell	in	the	top	left	corner	to	white	so	that	it	is	not	visible.	Troubleshooting	Data	Tables	Many	users	find	that	they	need	to	troubleshoot	their	Data	Tables.	The	following	is	a	list	of	the	six	most	common	Data
Table	errors	users	encounter:	1.	Workbook	Calculation	Settings:Multiple	Data	Tables	in	an	Excel	file	can	slow	down	the	speed	and	performance	of	the	file.	As	a	result,	there	is	a	setting	in	Excel	to	perform	automatic	workbook	calculations	except	for	Data	Tables.	Go	to	File	>	Options	>	Formulas.	Under	Calculation	options,	select	Automatic	except	for
data	tables.	2.	Data	Table	Input	Cells	Are	Reversed	(Row	Input	Cell	and	Column	Input	Cell	are	Switched):If	the	Data	Table	is	calculating	but	the	values	are	incorrect,	you	may	have	mis-linked	your	Data	Table	in	step	3	above.	Try	reversing	the	cells	in	the	Row	Input	Cell	and	Column	Input	Cell	fields	to	see	if	this	fixes	the	problem.	3.	The	Row	Headings
and	Column	Headings	are	Linked	to	the	Original	Inputs:If	the	Data	Table	is	calculating	with	incorrect	values	and	you	have	confirmed	the	Data	Table	is	properly	linked	(i.e.	the	issue	is	not	#2	above),	the	problem	may	be	due	to	the	row	headings	or	column	headings	in	the	table.	When	using	a	Data	Table,	the	row	headings	and	column	headings	must	be
independent	of	the	original	inputs.	You	cannot	link	any	of	the	row	headings	or	column	headings	to	the	actual	data	inputs	that	drive	the	original	calculations	(cells	D4	or	D7	in	the	example	above).	4.	Data	Table	is	on	a	Different	Worksheet	than	the	Original	Inputs:Excels	Data	Table	must	be	on	the	same	worksheet	as	the	original	inputs	being	sensitized.
In	our	example,	the	Data	Table	must	be	located	on	the	same	worksheet	as	the	original	revenue	growth	and	EBITDA	margin	assumptions.	If	you	attempt	to	link	the	Data	Table	to	cells	on	a	different	worksheet,	you	will	get	an	error	message.	5.	Cells	in	the	Table	Are	Not	Consistently	Locked/Unlocked:Another	issue	that	leads	to	error	messages	occurs
when	cells	are	inconsistently	locked.	All	of	the	cells	in	a	Data	Table	must	have	the	same	locked	attribute.	The	cells	must	all	either	be	locked	or	unlocked.	Attempting	to	run	the	Data	Table	tool	when	all	the	cells	in	the	table	are	not	consistent	will	result	in	an	error.	To	check	or	change	the	locked	settings	of	a	cell,	select	the	cell,	go	to	the	Format	Cells
menu	(CTRL	+	1),	and	choose	the	Protection	tab.	6.	Other	Data	Table	Issues:If	you	attempt	to	delete	a	single	cell	in	a	Data	Table	or	if	you	try	to	insert	a	column	or	row	into	your	Data	Table,	you	will	get	an	error	message.	These	errors	occur	because	the	Data	Table	creates	an	array	and	a	defining	characteristic	of	arrays	is	that	you	cannot	change	only	a
section	of	an	array	(you	must	change	all	of	it	or	none	of	it).	If	you	enjoyed	reading	this	and	want	to	improve	your	skills	further,	then	try	our	Excel	Best	Practices	Self-Study	Course.	You	can	also	browse	our	other	range	ofSelf-Study	Courses	here.	Training	The	Street	also	offers	a	more	advanced	In-Person/Virtual	Public	Course	called,Applied	Excel.
Where	you	can	gain	the	skills	needed	for	parsing,	analyzing,	and	presenting	information	from	large	data	sets.	Browse	our	other	Resources:	The	Calculation	Options	choose	the	way	you	calculate	in	Excel.	Sometimes,	it	is	convenient	for	us	to	receive	a	result	from	the	calculations	instantly,	or	sometimes	it	is	best	to	recalculate	at	the	end.	The	good	news
is,	that	you	can	change	when	and	how	Excel	recalculates	formulas	using	the	Calculation	Options.	This	article	will	give	you	an	overview	of	the	Calculation	Options	and	how	to	use	them	in	Excel.How	to	Use	Calculation	Options	in	ExcelTo	use	Calculation	Options	in	Excel,	follow	the	steps	below:First,	click	on	the	Formulas	tab.Now	from	the	Calculation
group,	hit	the	Calculation	Options	drop-down	menu.You	will	see	the	Automatic	mode	is	the	default	mode.From	the	Calculation	Options	drop-down	menu,	choose	any	mode	as	per	your	preference.To	activate	the	Manual	mode,	click	on	the	Manual	command.Choose	the	Calculate	Now	or	the	Calculate	Sheet	command	to	recalculate	again.Modes	of
Calculation	Options	in	ExcelThe	Calculation	Options	in	Excel	allow	you	to	compute	in	3	distinct	ways.1.	AutomaticGenerally,	the	Automatic	option	is	the	default	setting	in	Excel	sheets.	The	Automatic	mode	is	for	recalculating	when	a	formula,	function,	value,	cell	address,	or	cell	range	is	changed.	It	also	plays	an	active	role	when	a	formula	is	filled	in
multiple	cells.2.	Automatic	Except	for	Data	TablesThe	recalculation	feature	stays	active	with	the	Automatic	Except	for	Data	Tables	calculation	mode,	except,	it	is	inactivated	for	Data	Tables.3.	ManualThe	Manual	mode	stops	the	automatic	recalculation	method.	To	reactivate	the	Automatic	mode,	click	the	Calculate	Now	or	Calculate	Sheet
command.Keyboard	Shortcuts	for	Using	Calculation	Options	in	ExcelAutomatic	Mode:	Press	ALT+A.Automatic	Except	for	Data	Tables	Mode:	Press	ALT+D.Manual	Mode:	Press	ALT+M.ConclusionMicrosoft	Excels	Calculations	Options	are	beneficial	if	you	know	how	to	properly	use	them	in	worksheets.	I	hope	you	get	an	overall	idea	of	when	to	use
which	of	the	Calculation	Options	in	Excel.	Please	visit	our	Blogpage	for	more	Excel-related	writing.	Also,	dont	forget	to	comment	if	you	find	anything	confusing.	Thank	you.Excel	Glossary	|	Autosum	|	Fill	Handle	|	Conditional	Formatting	|	Merge	&	Center	|	Wrap	Text	|	Flash	Fill	|	Find	&	Replace	|	Freeze	Panes	|	Format	Painter	|	Format	Cells	|	Sort	&
Filter	|	Advanced	Filter	|	Text	to	Columns	|	Go	To	Special	|	Name	Manager	|	Excel	Table	|	Slicer	|	Power	Query	|	Add-ins	Rhidi	BarmaData	AnalystRhidi	Barma	is	a	professional	Excel	user	who	has	written	many	interesting	articles	for	us	at	Excelgraduate.com.	She's	a	graduate	from	Jahangirnagar	University,	Bangladesh	and	has	been	working	with
Microsoft	Excel	since	2015.	She	loves	writing	articles	on	MS	Excel	tips	&	tricks,	data	analysis,	business	intelligence,	capital	market,	etc.	The	tutorial	explains	the	basics	of	Excel	calculation	settings	and	how	to	configure	them	to	have	formulas	recalculated	automatically	and	manually.To	be	able	to	use	Excel	formulas	efficiently,	you	need	to	understand
how	Microsoft	Excel	does	calculations.	There	are	many	details	you	should	know	about	basic	Excel	formulas,	functions,	the	order	of	arithmetic	operations,	and	so	on.	Less	known,	but	no	less	important	are	"background"	settings	that	can	speed	up,	slow	down,	or	even	stop	your	Excel	calculations.Overall,	there	are	three	basic	Excel	calculations	settings
you	should	be	familiar	with:Calculation	mode	-	whether	Excel	formulas	are	recalculated	manually	or	automatically.Iteration	-	the	number	of	times	a	formula	is	recalculated	until	a	specific	numeric	condition	is	met.Precision	-	the	degree	of	accuracy	for	a	calculation.In	this	tutorial,	we	will	have	a	close	look	at	how	each	of	the	above	settings	works	and
how	to	change	them.	These	options	control	when	and	how	Excel	recalculates	formulas.	When	you	first	open	or	edit	a	workbook,	Excel	automatically	recalculates	those	formulas	whose	dependent	values	(cells,	values,	or	names	referenced	in	a	formula)	have	changed.	However,	you	are	free	to	alter	this	behavior	and	even	stop	calculation	in	Excel.	On	the
Excel	ribbon,	go	to	the	Formulas	tab	>	Calculation	group,	click	the	Calculation	Options	button	and	select	one	of	the	following	options:Automatic	(default)	-	tells	Excel	to	automatically	recalculate	all	dependent	formulas	every	time	any	value,	formula,	or	name	referenced	in	those	formulas	is	changed.Automatic	Except	for	Data	Tables	-	automatically
recalculate	all	dependent	formulas	except	data	tables.Please	do	not	confuse	Excel	Tables	(Insert	>	Table)	and	Data	Tables	that	evaluate	different	values	for	formulas	(Data	>	What-If	Analysis	>	Data	Table).	This	option	stops	automatic	recalculation	of	data	tables	only,	regular	Excel	tables	will	still	be	calculated	automatically.Manual	-	turns	off
automatic	calculation	in	Excel.	Open	workbooks	will	be	recalculated	only	when	you	explicitly	do	so	by	using	one	of	these	methods.Alternatively,	you	can	change	the	Excel	calculations	settings	via	Excel	Options:In	Excel	2010	-	Excel	365,	go	to	File	>	Options	>	Formulas	>	Calculation	options	section	>	Workbook	Calculation.In	Excel	2007,	click	Office
button	>	Excel	options	>	Formulas	>	Workbook	Calculation.In	Excel	2003,	click	Tools	>	Options	>	Calculation	>	Calculation.Tips	and	notes:Selecting	the	Manual	calculation	option	(either	on	the	ribbon	or	in	Excel	Options)	automatically	checks	the	Recalculate	workbook	before	saving	box.	If	your	workbook	contains	a	lot	of	formulas,	you	may	want	to
clear	this	check	box	to	make	the	workbook	save	faster.	If	all	of	a	sudden	your	Excel	formulas	have	stopped	calculating,	go	to	Calculation	Options	and	make	sure	the	Automatic	setting	is	selected.	If	this	does	not	help,	check	out	these	troubleshooting	steps:	Excel	formulas	not	working,	not	updating,	not	calculating.	If	you	have	turned	off	Excel	automatic
calculation,	i.e.	selected	the	Manual	calculation	setting,	you	can	force	Excel	to	recalculate	by	using	one	of	the	following	methods.To	manually	recalculate	all	open	worksheets	and	update	all	open	chart	sheets,	go	to	the	Formulas	tab	>	Calculation	group,	and	click	the	Calculate	Now	button.To	recalculate	only	the	active	worksheet	as	well	as	any	charts
and	chart	sheets	linked	to	it,	go	to	the	Formulas	tab	>	Calculation	group,	and	click	the	Calculate	Sheet	button.Another	way	to	recalculate	worksheets	manually	is	by	using	keyboard	shortcuts:F9	recalculates	formulas	in	all	open	workbooks,	but	only	those	formulas	that	have	changed	since	the	last	calculation	and	formulas	dependent	on	them.Shift	+	F9
recalculates	changed	formulas	in	the	active	worksheet	only.Ctrl	+	Alt	+	F9	forces	Excel	to	recalculate	absolutely	all	formulas	in	all	open	workbooks,	even	those	that	have	not	been	changed.	When	you	have	the	feeling	that	some	formulas	are	showing	incorrect	results,	use	this	shortcut	to	make	sure	everything	has	been	recalculated.Ctrl	+	Shift	+	Alt	+
F9	checks	formulas	dependent	on	other	cells	first,	and	then	recalculates	all	formulas	in	all	open	workbooks,	regardless	of	whether	they	have	changed	since	the	last	calculation	or	not.	Microsoft	Excel	uses	iteration	(repeated	calculation)	to	compute	formulas	that	refer	back	to	their	own	cells,	which	is	called	circular	references.	Excel	does	not	calculate
such	formulas	by	default	because	a	circular	reference	can	iterate	indefinitely	creating	an	endless	loop.	To	enable	circular	references	in	your	worksheets,	you	must	specify	how	many	times	you	want	a	formula	to	recalculate.	To	turn	on	Excel	iterative	calculation,	do	one	of	the	following:In	Excel	2016,	Excel	2013,	and	Excel	2010,	go	to	File	>	Options	>
Formulas,	and	select	the	Enable	iterative	calculation	check	box	under	the	Calculation	optionsIn	Excel	2007,	click	Office	button>	Excel	options	>	Formulas	>	Iteration	area.In	Excel	2003	and	earlier,	go	to	Menu>	Tools	>	Options	>	Calculation	tab	>	Iterative	Calculation.To	change	the	number	of	times	your	Excel	formulas	can	recalculate,	configure	the
following	settings:In	the	Maximum	Iterations	box,	type	the	maximum	number	of	iterations	allowed.	The	higher	the	number,	the	more	slowly	a	worksheet	is	recalculated.In	the	Maximum	Change	box,	type	the	maximum	amount	of	change	between	the	recalculated	results.	The	smaller	the	number,	the	more	accurate	the	result	and	the	longer	a	worksheet
recalculates.	The	default	settings	are	100	for	Maximum	Iterations,	and	0.001	for	Maximum	Change.	It	means	that	Excel	will	stop	recalculating	your	formulas	either	after	100	iterations	or	after	a	less	than	0.001	change	between	iterations,	whichever	comes	first.With	all	the	settings	configured,	click	OK	to	save	the	changes	and	close	the	Excel	Options
dialog	box.	By	default,	Microsoft	Excel	calculates	formulas	and	stores	the	results	with	15	significant	digits	of	precision.	However,	you	can	change	this	and	make	Excel	use	the	displayed	value	instead	of	the	stored	value	when	it	recalculates	formulas.	Before	making	the	change,	please	be	sure	you	fully	understand	all	possible	consequences.In	many
cases,	a	value	displayed	in	a	cell	and	the	underlying	value	(stored	value)	are	different.	For	example,	you	can	display	the	same	date	in	a	number	of	ways:	1/1/2017,	1-Jan-2017	and	even	Jan-17	depending	on	what	date	format	you	set	up	for	the	cell.	No	matter	how	the	display	value	changes,	the	stored	value	remains	the	same	(in	this	example,	it's	the
serial	number	42736	that	represents	January	1,	2017	in	the	internal	Excel	system).	And	Excel	will	use	that	stored	value	in	all	formulas	and	calculations.Sometimes,	the	difference	between	the	displayed	and	stored	values	can	make	you	think	that	a	formula's	result	is	wrong.	For	example,	if	you	enter	the	number	5.002	in	one	cell,	5.003	in	another	cell
and	choose	to	display	only	2	decimal	places	in	those	cells,	Microsoft	Excel	will	display	5.00	in	both.	Then,	you	add	up	those	numbers,	and	Excel	returns	10.01	because	it	calculates	the	stored	values	(5.002	and	5.003),	not	the	displayed	values.Selecting	the	Precision	as	displayed	option	will	cause	Excel	to	permanently	change	stored	values	to	the
displayed	values,	and	the	above	calculation	would	return	10.00	(5.00	+	5.00).	If	later	on	you	want	to	calculate	with	full	precision,	it	won't	be	possible	to	restore	the	original	values	(5.002	and	5.003).If	you	have	a	long	chain	of	dependent	formulas	(some	formulas	do	intermediate	calculations	used	in	other	formulas),	the	final	result	may	become
increasingly	inaccurate.	To	avoid	this	"cumulative	effect",	it	stands	to	reason	changing	the	displayed	values	via	custom	Excel	number	format	instead	of	Precision	as	displayed.For	example,	you	can	increase	or	decrease	the	number	of	displayed	decimal	places	by	clicking	the	corresponding	button	on	the	Home	tab,	in	the	Number	group:	If	you	are
confident	that	the	displayed	precision	will	ensure	the	desired	accuracy	of	your	Excel	calculations,	you	can	turn	it	on	in	this	way:Click	the	File	tab	>	Options,	and	select	the	Advanced	category.Scroll	down	to	the	When	calculating	this	workbook	section,	and	select	the	workbook	for	which	you	want	to	change	the	precision	of	calculations.Check	the	Set
precision	as	displayed	box.Click	OK.This	is	how	you	configure	calculation	settings	in	Excel.	I	thank	you	for	reading	and	hope	to	see	you	on	our	blog	next	week!	

Excel	calculation	automatic	except	for	data	tables.	Automatic	except	for	data	tables.	Automatic	except	for	data	tables	meaning.	Why	use	tables	in	excel.	Excel	table	data	example.


